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It serves as the template for video construction. Chapter 3: Edit Player The Player consists of the preview area on the right side of the screen and all the controls below it. The following buttons may also be available. On the right is a column of text styles. In the Create module, check the "Auto-Pan &... 85 Customer Support...86 Technical Support ...87
Registering Your Product...88 ArcSoft Product Family ...89 Licensing Agreement ...92 About ArcSoft...96 INDEX ... See Chapter 2. Chapter 1: Introduction Workflow Overview ShowBiz DVD 2 is divided into four main sections, or "modules." You can start in any module, depending on what you are interested in! Capture Record video from your DV
camera or other video device. Selecting an option takes you right into one of the four modules: Create, Edit, Capture, or Quick DVD. Albums consist of shortcuts that link to the picture, music, and video files stored on your computer. working in the Set Chapters tab, an area like this appears beneath the preview area, showing you a "tree view"...
Albums Albums are collections of shortcuts to files stored on your system. Chapter 3: Edit Transitions Transitions are special effects that can be inserted between video clips or still images on the Storyboard/Timeline. In this chapter, rather than descriptions of the user interface function by function, you'll find short "how to" procedures for common
tasks. Setting chapters is only available for DVD projects. If you update one thumbnail frame and would to apply that frame either to all thumbnails on the current menu or to all thumbnails throughout the project, right-click the thumbnail and choose "Apply frame to all thumbnails in this menu"... Each video you add is made into its own chapter in
your movie. Chapter 6: Menus Edit The following commands are available under the Edit menu: Undo - Reverses the last command. Page 68 Chapter 6: Menus Set Thumbnail: ALT + U Write Disc: ALT + R Start: ALT + A Main Menu: ALT + U Intro: ALT + I Quick DVD: CTRL + D Player Shortcuts: Active Clip: ALT + A Entire Project: ALT + ]
Storyboard View: ALT + Y Timeline View: ALT + L Video Track: CTRL + 1... Modification 6: Customizing Menu Text To customize menu text, click the Text tab. Simply click on the text you want in the preview area, then edit as you see fit. 1. Settings include: default display time for still images, text, transitions, and special effects; automatic scene
detection; automatic rewind; progressive or interlaced video; TV standard (NTSC or PAL);... 15 Video Clip Components ...17 Player ...18 Media ...20 Storyboard...23 Timeline ...26 Text ...30 Transitions ...32 Effects...33 Export ...34... Chapter 7: How Tos Create DVD The Create module of the program is where you actually put together your DVD (or
VCD). You can alter the font, size, style (bold and italic), and text color. Chapter 3: Edit Video Clip Components Everything you need to create your video clips is in one of four tabs: Media, Text, Transitions, and Effects. Use the preview to get an idea how the effect works. Page 4 Create Slide Show...75 Add Pan & Zoom ...76 Perform Advanced Editing
...78 7.10 Design Menus...80 7.11 Burn To Disc ...82 Reference... While working in the Timeline, you have the following options available: Undo - Undoes the last command. Page 15 Chapter 2: Capture Capturing from VFW Devices VFW ("Video for Windows") devices follow an older Microsoft multimedia framework. Chapter 3: Edit Effects Special
effects are included to help you spice up your movies. The smaller squares are for TRANSITIONS. System Requirements Minimum System Requirements Windows 2000/XP/Vista Pentium III 800 MHz or higher (P4 1.6 GHz or higher recommended) Memory 128 MB RAM (512 MB recommended) Hard disk space 400 MB available hard disk space for
program installation 4 GB+ free hard disk space recommended for video capture and editing (1 hour of DV video requires 13 GB of hard disk space) Hard drive... Create New Album In order to add content to the Storyboard/Timeline, you need to first create an album. Audio Device: Check the box if you would like to record audio as well. Page 81
Chapter 7: How Tos Step 3. Page 28 All of the components on the Storyboard are swappable, meaning you can drag and drop them to swap them with other components. Launch the program. DVD in just a few clicks. Double-click the theme that you want. Stop - Stops video playback. Chapter 4: Create Slide Shows Slide shows can be added to your
movie as separate chapters. Page 99 NOTES... Check the box to have the text scroll as it is displayed. Redo - Reverses the last Undo command. See Chapter 3. This makes it easy to rearrange video clips and still images, or swap transitions from one spot to another. Chapter 4: Create Create Media Themes Customize Text Set Chapters Preview Area
Slide Shows Write Disc... Chapter 7: How Tos How Tos Capture Video Capture Audio Create New Album Add Content to Storyboard Modify Content Create DVD Create Slide Show Add Pan & Zoom Perform Advanced Editing Design Menus Burn to Disc... You can then choose the exact menu background. See Chapter 4. The display will then "pan &
zoom" to the "End" marquee. Page 72 Chapter 7: How Tos ShowBiz DVD can seem like a complex program. Chapter 6: Menus Extras & Help The following commands are available under the Extras menu: More ArcSoft Products - Offers additional ArcSoft products that complement your program. Use the Player to preview and trim your video clip as
you compile it. Chapter 4: Create Text In the Text tab, you can modify any text that appears on any menu. Select to record audio from a CD or from a recording device. Page 83 Chapter 7: How Tos Step 4. Chapter 6: Menus View The following commands are available under the View menu: Capture - Takes you to the Capture module. * Use the top
timer to modify the display time for each still image. Page 60 Chapter 6: Menus The menus are located at the top of the program desktop. Click this button to set the starting point of the video at the current position of the timer. The available options for a transition vary depending on the type of transition you choose. (This option is not available when
creating DVD-VR discs, or when saving your project to your hard drive.) 8. The scroll buttons designate in which direction the added text will move. Chapter 3: Edit Text Add text over any video clip or still image. USE OF THE SOFTWARE (defined below) PROVIDED BY ARCSOFT IS PERMITTED ONLY UNDER AND IN ACCORDANCE WITH THIS
AGREEMENT. Chapter 4: Create Themes The Themes tab is where you add background images to your projects. Recent Projects - Displays a list of the most recently opened... Suits or enforcement actions must be brought within, and each party irrevocably commits to the exclusive jurisdiction of the state and federal courts located in Santa Clara
County. Capture Video Step 1. You can choose the thumbnail borders as well as the thumbnail arrangements. Choose a set effect, or "All Effects (Random)," to have the program randomly insert transitions between each slide. If you check the box, choose your device from the pull-down. Page 20 Chapter 3: Edit The Edit module is where you assemble
various components to create a new video clip. 3. 3 System Requirements... Table of Contents Introduction ... 5 Capture... Chapter 2: Capture Capture Video Capture Audio Capture... Chapter 5: Quick DVD Quick DVD... Choose Audio to record sound clips, voiceovers, and other sounds. If recording from a CD, select the track and then use the playback
controls to jump to the spot where you would like to begin recording. Use the arrows at the beginning and end of the Storyboard to scroll through additional components if you cannot view them all on screen. Media - Choose still images, video files, and audio files that you'd like to use to create a new video clip. Page 33 components uneditable. Edit
Edit your videos and combine them with other video clips, transitions, effects, text, and more. It offers a more in-depth view of your constructed movie than the Storyboard. You can also click the "New Background" button in the preview area and browse your system for an image that you want to use. Installation Insert the CD into your CD-ROM drive.
Page 96 Mozilla, 34 MPEG, 51, 60 MPEG-2, 69 Name Slide Show, 47 New Background, 38, 43, 81 New Project, 57 Next Frame, 61 NTSC, 10, 48, 60, 82 Open Project, 57 Options menu, 60 Orient Photos, 45 Outlook Express, 34 PAL, 10, 48, 60, 82 Pan &... Just follow the instructions in each step. Select the slide you want, and then click "Audio
Annotation."... You can recombine two split videos by selecting them both on the Storyboard or Timeline, right-clicking, and selecting Combine. Transitions are only available for DVD projects. The preview area on the right side of the screen shows you your current movie layout. This button plays the selected video clip. Working closely with major
OEM manufacturers, ArcSoft offers a full line of imaging and video solutions that enhance the features, performance, and user experience of mobile phones, digital cameras, optical drives, personal computers, and consumer electronics devices. You can also use it to play your DVD. This option is only available for DVD projects. Chapter 3: Edit Edit
Video Clip Components Player Media Storyboard Timeline Text Transitions Effects Export... All rights reserved. Page 6 Chapter 1: Introduction Welcome to ArcSoft ShowBiz® DVD 2, a powerful video application that includes everything you need to edit your home videos and create spectacular DVDs. This Introduction covers the installation and
system requirements and provides an overview of the typical ShowBiz workflow. INDEX < New Album >, 21, 71 < New Theme >, 38 Acquire, 21 Acquire Photos, 45, 75 Active Clip, 18 Add, 21 Add Audio, 46 Add Photos, 45, 75 Add to Album, 12 album, 14, 20 Animated Thumbnails, 80 animation, 44 antenna, 9 Arrange Photos, 45... 4 Workflow
Overview ... (Specific options are dependent on your device. Chapter 6: Menus Options The following commands are available under the Options menu: Preferences - Lets you view and modify various program settings. The top meter shows the amount of available and required space to create your movie. When you do, a virtual remote control
appears, letting you navigate through the DVD menu in the same way that you would on your TV. Page 29 Chapter 3: Edit the timer to the spot where you want the split performed, then right-click the video component on the Storyboard or Timeline and select Split. Take note as to where the program is installing, and where it can be found in the Start
menu. The Storyboard consists of several squares. If you are extracting audio from a CD, select the letter associated with the drive you plan to use. Previous Frame -... See Section 7.8 for more information. Page 46 Click this button to set the current frame as the thumbnail for the chapter. Optionally, you can also enter the date, which will appear
below the title. Page 26 Scene Detection Scene detection makes it easy for you to break up long video clips into separate components without having to save each clip individually. Page 2 Tel: +1.510.440.9901 ¢ Fax: +1.510.440.1270 « www.arcsoft.com Copyright © 2007 ArcSoft, Inc. The left timer indicates the total playing time of the selected
component. The wizard walks you through each simple step. Step 2. Paste -... Copyright. Page 16 Chapter 2: Capture Check the Audio Device box to record audio from your selected sound source. (Transitions are effects that occur as one video or image changes to another.) When your final movie is compiled, everything on the Storyboard is combined
into a single video file. Page 48 reusable template under the Themes section. It contains four primary tabs, one for each type of component you can add to your video clip: Media, Text, Transitions, Effects. A standard Open window lets you browse your system for files to add. Chapter 6: Menus Menus File Edit View Options Play Extras & Help
Keyboard Shortcuts... Add - Click this button to add files to your album. This virtual remote control lets you use the preview area as a TV. This chapter also includes information on keyboard shortcuts. You add a still image or video clip to each spot on the Storyboard. Themes are albums of categorized images that can be used as menu backgrounds for
your DVD. The module is divided into six tabs: Media - In this tab, you choose individual video files that you want to use in your DVD movie. A special license permit from ArcSoft is required if the program is going to be installed on a network server for the sole purpose of distribution to other computers. Chapter 6: Menus Play The following
commands are available under the Play menu: Play/Pause - Starts/pauses playback of the currently selected video component. Page 51 Chapter 4: Create Once you have gotten this far in creating your slide show, click "Next." Transitions Transitions are effects that occur when one slide changes to another. From the pull-down, select the category you
wish to view. With Text selected, your mouse functions as it would in a word processor. Page 58 Chapter 5: Quick DVD... Add the selected text component to your project by dragging it to the Storyboard/Timeline. You can then preview the CD tracks with the standard playback controls (play, stop, rewind, etc.). "Preview Animation" to see it at work.
Double-clicking the respective chapter button lets you edit an existing slide show. Chapter 3: Edit Timeline The Timeline is the other place where you arrange your video clip components. The Software or the Software contained in this... Cut - Removes the selected component and stores it in memory. (The Export section only appears once you have
components on the Storyboard/Timeline.) You choose how and where the file is saved. PLEASE READ THE FOLLOWING TERMS ("Agreement") CAREFULLY. See Section 3.4 and Section 7.5 for more information. Sort - Click this button to sort the content of your album in a number of ways. Scene detection is discussed further in Section 3.3. If you
choose to have scene detection, you can either do it manually during the capture process (by pressing the space bar on your keyboard), or automatically. It consists of two tabs: Video and Audio. Page 85 Modification 5: Choosing a New Background To choose a new background, click the Themes tab. TV Safe Zone -... There are a few sample albums
included in the program. Edit ArcSoft DVD Disc - Lets you edit the contents of a previously created ArcSoft DVD. Click this button to se the ending point of the video at the current position of the timer. The rest of the user manual covers how to capture video, edit and assemble video clips, and create a DVD movie. 7 Video Capture ... Page 23 There
are two timers. Add Content to Storyboard The Storyboard is where you add content to piece together your movie. The program uses albums to help you organize your media components. Choose the drive to which your DVD will be saved. Click and drag audio to this spot to have music/narration play during the current menu. Content includes still
images, video files, and audio files. Chapter 4: Create Media The Media tab is where you choose the videos you want to include in your DVD movie. Copy - Places a copy of the selected component in memory. You can also choose a menu design. The right timer indicates the current time. Chapter 4: Create Write Disc This is the final step in creating
your DVD or VCD. Preview. Page 88 Chapter 7: How Tos... Page 35 alignment, color, and style (bold and italic). Chapter 4: Create Set Chapters The Set Chapters tab lets you trim video clips and break them up into multiple chapters. Chapter 2: Capture Video Capture You can capture video from a multitude of video devices, including DV camcorders.
The Text tab is divided into two categories: Style and Effect. Capturing from a DV Tape When capturing from a DV device, playback controls appear. Chapter 7: How Tos 7.10 Design Menus Once you have added content to your DVD in the Create module, you can customize the look and feel of your menu. If you like the style and color of a particular
string of text that you have added and would like to apply those settings either to all other text on the current menu or to all other text throughout the... A fifth tab, Export, appears as soon as you have content in your video clip. Chapter 3: Edit Storyboard The Storyboard is one place where you arrange your video clip components. Create - Takes you
to the Create module. Finally, set the number of discs to be burned. When you're all ready to go, click the Write Disc tab in the Create module. When you're ready, click the red Record button. From the pull-down, select the category you want. Chapter 4: Create Customize The Customize tab lets you customize the look and feel of the chapter
thumbnails seen in your menus. See Chapter 5. Click and drag an effect onto any video clip or still image on the Timeline. Editing Text Effects. You can choose either a DVD writeable (or rewriteable) drive, or your hard drive. Chapter 5: Quick DVD Quick DVD Steps The Quick DVD wizard guides you through the following steps. In the Layout section,
double-click the layout that you want. Page 95 DVD Options, 51, 60 DVD Quality Setting, 60 DVD+VR, 51 DVD-Video, 51 DVD-VR, 51, 53 Edit, 59 Edit ArcSoft DVD Disc, 57 Edit menu, 58 Edit Mode, 30 Move, 31 Text, 31 Edit module, 20, 71, 72, 76, Edit Photo, 75... Chapter 2: Capture Audio Capture When capturing audio, you have the choice of
extracting music from a CD, or recording audio from a sound device. Click the Audio tab. Page 87 Chapter 7: How Tos When you're ready, click "OK." Your movie is converted into DVD or VCD format, and the burned to your disc or written to your hard drive. The lower meter shows you the progress in the creation of your movie. 9 Audio Capture ...14
Edit... When viewing an audio or video component, the timer (slider) beneath the preview window has two markers: the Start Marker and the End Marker. Page 17 Chapter 2: Capture Lastly, you can set the scene detection. This is the time that the image remains on the screen before changing to the next component on the Timeline. Page 69 Open
Project: CTRL + O Save Project: CTRL + S Save Project As: CTRL + SHIFT + S Import Media File: CTRL + I Edit ArcSoft DVD Disc: CTRL + E Start/Pause Video: SPACE Stop/Rewind: HOME Previous Frame: ALT + Left ARROW... Choose Video to record video from DV camcorders and other connected devices. 97... Chose the one you like best. Videos
that contain multiple chapters will automatically be turned into their own submenus. In the Transitions tab, choose your transition from the available categories, then click the arrow to add it to the Storyboard/Timeline. Every component that you have added (still images, videos, audio, transitions, text, and special effects) can be seen and altered here.
In the Save As window, enter in the file name and save location for the captured video. The menus include: File, Edit, View, Options, Play, Extras, and Help. In the Effects tab, they are organized into various categories including crop shapes, frames, and filters. Follow the on-screen instructions to complete the installation. The program scans the
selected video file and automatically breaks it up according to changes in time or content. Save As For capturing from any device, after you click the red Record button, you'll be prompted with the Save As window. Chapter 7: How Tos Modify Content This section covers simple content modifications that can be done on the Storyboard. Edit - Takes
you to the Edit module. Updates and Patches - Automatically detects and installs the latest program updates to your software. ArcSoft, the ArcSoft logo, and ArcSoft ShowBiz are registered trademarks of ArcSoft, Inc. Page 98 NOTES... To start creating a slide show, make sure you are in the Media tab of the Create module and click the "Create
Slideshow"... Redo -... Page 40 Chapter 4: Create The Create module is where you go after you have edited your video files, when you want to create a DVD or VCD. Older webcams, USB devices, or PCI devices may use the VFW standard. The Player contains standard play/pause/rewind buttons, along with other controls that depend on what you are
previewing or recording. Then, when you save your video, all of the components are combined into a single file. Page 50 Add Pan & Zoom Effects The Pan & Zoom option lets you add a unique movement effect to your slides. Preview Area The preview area shows you how your DVD menu will appear. When you are in the Capture module, a red Record
button in the Player lets you start capturing video. All of the components on the Storyboard/Timeline will be combined into a single video file. You can use these controls to navigate to a specific location on the DV tape. Page 10 Chapter 1: Introduction When you first launch ShowBiz, the Welcome screen offers several options for common starting
places. Modification 1: Organizing Chapter Buttons To organize the chapter buttons, click the Customize tab. The wizard is designed to guide you throughout the entire process. Page 97 special effects, 27, 33 editing, 28 Split, 24, 27, 29 Start Marker, 19 still images, 27, 72 editing, 27 Stop, 61 Storyboard, 23, 59, 72, 76 Storyboard/Timeline, 20
Stretch to Fit, 27, 60 Style, 30 Style category, 30, 79 submenu, 38, 41, 81 Temporary Folder, 60 text, 26, 30 Text Editor, 79... All other product and companies named herein may be trademarks of their respective owners. Text -... To perform more advanced editing, you need to use the Timeline. Page 31 beginning or end of video clips or the entire
movie), and cut, copy, and paste commands. Chapter 1: Introduction Introduction Installation System Requirements Workflow Overview... When the slide show reaches the photo, the focus will be exclusively on the "Begin" marquee. Launch the program and click "Capture" at the top of the screen to go to the Capture module. From the welcome
wizard, select "Capture, create, or edit videos." From the next screen, select "Capture From Device." If you already have the program open, click "Capture" at the top of the screen to go to the Capture module. Page 54 Chapter 5: Quick DVD By choosing the Quick DVD option, you'll have a "wizard" that will walk you through each step in order to
capture and create your movie. IN NO EVENT WILL ARCSOFT BE LIABLE TO YOU FOR DAMAGES IN AN AMOUNT GREATER THAN THE FEES PAID FOR THE USE THE FOREGOING LIMITATIONS APPLY TO THE EXTENT PERMITTED BY APPLICABLE LAWS IN YOUR JURISDICTION. Click this button to remove all chapter points from the video.
Click the Style category you want ("Simple" or "Fancy"), then click and drag the particular text style you want to the Timeline. Chapter 7: How Tos Add Pan & Zoom Pan & Zoom is a neat effect that can be applied to photos on the Storyboard while in the Edit module, or to slides in slide shows created in the Create module. Step 1. The Text Editor
appears. Reference otherwise specified as not for resale. Page 1 User Manual... Add Audio You can attach music files to each slide. Play Entire Storyboard/Timeline - Plays all of the components on the Storyboard/Timeline in order. Note: If the installer does not start automatically, you will need to run it manually: Insert the CD into your CD-ROM
drive. Create Slide Show You can create a photo slide show, which is added to your movie as a separate chapter. To add text, click the Text tab. IF YOU DO NOT AGREE TO BE BOUND BY THIS AGREEMENT, PLEASE DO NOT USE THIS SOFTWARE. Page 12 Chapter 2: Capture The Capture module is where you record video and audio. Options for
editing text are discussed in Section 3.6. Page 32 ¢ Drag the sliders to the left of the Player to adjust the brightness, contrast, hue, and saturation. For more information on advanced editing, see Section 3.5 and Section 7.9. Modification 1: Rearranging Photos and Videos Rearrange photos and videos on the Storyboard by clicking and dragging any
thumbnail on the Storyboard to a new location. You can start the Quick DVD wizard at any time by selecting File > Quick DVD. Reference exclude the application of the United Nations Convention on Contracts for the International Sales of Goods. The installer should start automatically. Capture Audio Step 1. CONTRACT, TORT (INCLUDING
NEGLIGENCE) OR OTHERWISE), EVEN IF ARCSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. This is useful if you want to move around or edit specific areas without having to worry about unintentionally modifying other components. Then, use the left and right arrows to browse through the different designs within the
category. Chapter 3: Edit Media The Media tab of the Edit module is where you browse your albums for video content. Page 57 Chapter 5: Quick DVD You can also choose a menu design. Chapter 7: How Tos Perform Advanced Editing On the Storyboard, you can perform basic content modification, including adding still images, video clips, and
transitions to your movie, as well as enhance your still images and trim your video clips. The available options vary depending on the device. dragging. Click within the text box to modify the sample text, or add more text by clicking anywhere outside the existing text box. To edit text effects, click the Edit Text button that appears on the left of the
Player. Components from the Effect category are attached to the actual text messages from the Style category. Page 25 new name for your album (or rename any album) by simply typing over the existing name. To capture video from VFW devices, select your desired VFW device from the pull-down. 1 Installation ... Chapter 3: Edit Export The Export
tab offers various options for saving your video. 7.11 Burn To Disc Once your video clips and menus are all ready to go, you can preview your project, choose the output options, and burn it to disc. Click on any text option to preview it in the Player. Page 70 Chapter 6: Menus... Page 56 Chapter 5: Quick DVD - Capture one video to DVD: Enter a title
for your movie. Chapter 6: Menus Keyboard Shortcuts Menu Shortcuts: File: ALT + F Edit: ALT + E View: ALT + V Options: ALT + O Play: ALT + P Extras: ALT + X Help: ALT + H Capture Module: ALT + 1 Capture Video: ALT + I Capture Audio: ALT + U Live Toggle: ALT + L... The larger squares are for STILL IMAGES and VIDEOS. IF YOU... Launch
the program and click "Create" at the top of the screen to go to the Create module. in the United States. Page 14 Chapter 2: Capture Auto Scan: Click to have the program scan for available channels. Connect your camera to the computer and turn the power on.

03/05/2021 - The instructions are very simple and straightforward. I hooked up all the necessary cable (power, 2 HDMI cables - 1 In, 1 Out) then plugged in my 64GB USB 3 thumb drive formatted NTFS. According to the manual, NTFS will record a single file while FAT32 will record as many 2GB files as necessary. 15/02/2015 - Plus, ArcSoft
PhotoStudio works with all major formats, including RAW files from high-quality digital cameras. If you've seen Photoshop, you'll be familiar with ArcSoft ... ArcSoft ShowBiz 5.0.1.420. 3.4 ... Download. ArcSoft Medialmpression 3.5.255.985. 3.3 (187 votes) Organize your photos, videos and music. Download. Easy Photo ... ArcSoft Photolmpression is a
powerful, feature-filled photo editing application that doesn't make creating classy graphics too difficult to achieve. It has to be said that PhotoImpression pulls this off pretty well, and its colorful interface manages to marry some of the advanced features of programs like Photoshop with the simplicity of an app like the GIMP or IrfanView.
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